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1.You use Microsoft Outlook 2010 for messaging and e-mailing. MS Outlook has been configured to use
an IMAP account. You compose an e-mail. The e-mail comprises some confidential information. You
want to ensure that the recipients of the e-mail see the "Please treat this as Confidential" message in
the Information Bar of the e-mail. Which of the following actions will you take to accomplish the task?

A. Change the importance level.

B. Assign a Flag.

C. Use RSS Feeds.

D. Change the sensitivity level.

Answer: D

2.Mark works as a Marketing Manager for InfoTech Inc. He uses Microsoft Outlook 2010 for messaging
and emailing. MS Outlook has been configured to use the mark@radiant.com account. In Microsoft
Outlook 2010, a signature will automatically be added to the e-mails. However, Mark wants Outlook to
perform the following actions automatically: .?
1. Use the mark@InfoTech.com account.
2. Add a signature named Marketing_Manager to any message that Mark replies to or forwards.
3. Add a signature named Product_Manager to any new email message.
Perform the appropriate actions in the following Signatures and Stationery dialog box to accomplish the
task.
" Correct Answer ¥ Your Answer
signatures and Stationery [ 7]

E-mail Signature | Personal Stationery I

Select signature ba edit Choose defaulk signature
Marketing Manager E-mail account: I mark@InfoTech.com

Froduct_Manager
e s | Marketing_Manager

Replies/forvards: | Product_Manager

Lelladle

L

Delete | MNew I Save | Renamel

Edit signature

Werdana - |1U - | B [ U I_'”E = = |Q_|B_usinessCard L8 e
-
=l
Ok | Cancel |
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: :Eorrect Answer Your Answer
Signatures and Stationery ﬂ E

E-mail Signature | Personal Stationery |

Select signature to edit Choose default signature
Marketing_Manager E-mail account: Imark@lnfnTeu:h com ﬂ
Product_fManager
Mew messages: IF'rUdLlct_f'-;lanager j
F'1'3'3"'35"Em""‘5'rd5:| Marketing Manager ﬂ
w
Delete | MNew I Save | Rename |
Edit signature

Werdana - |ID v| B I U Iﬁ”%

= |&|B_usiness(:ard |E§ o,

A.
Answer: A

3.Configure the following calendar settings in the Outlook Options dialog box.

1. The work week of the calendar will be Monday to Friday, and the working hours of the calendar will be
10 AM.to 5 P.M.

2. First day of the week will be Wednesday.

. On the server, it will share the calendar information of 5 months.

. The server will update the availability information in every 20 minutes.

. First week of the year must be the first full week.

. The default reminder will be of 30 minutes.

. The users are allowed to suggest new meeting time.

. The response type while proposing a meeting must be Accept.

. The Arabic calendar is used as an alternative calendar in the Gregorian language.
10. It will include holidays of the United Kingdom.

© 00 N o 0o~ W
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| " Correct Answer  ® Your Answer |

Outlook Dptions

-
General . . . —
2| Change the settings for calendars, meetings, and time zones,
hail
Calendar Work time
Contacts ) wiark hours:
. Start time: 12:00 Al =]
asks —
End time: 130 AM =]
ITeieE ] SRl wiork week: W sun [T Mon 7 Tue [ owed W Thu W Fri W sat
Search First day of week: | Saturday ﬂ
Mobile Firstweek of year: |Full day week j
Language Calendar options
Advanced °>'ﬁ W Default reminders: |2 days j
Customize Ribbon B 2l Allowr attendees to propase new times for meetings
fQuick dccess Toolbar Lse this respanse when propasing a new meeting time: | Decling j
P Add holidays to the Calendar:  Add Holidays | | |

Change the permissions for wiewing Free/Busy information: ~ Free/Busy Options |
Trust Center

[ Enable an alternate calendar
|K0rean = |Um-a|-Qura |=

[ when sending meeting requests outside of your organization, use the iCalendar format

[~ Show bell icon on the calendar for appointments and meetings with reminders

Display options

a: %a Default calendar color: - |

I Usg this color on all calendars
Drate Mavigator font:

Fon & pt. Segoe UI

4 Showe Click to &dd prompts in calendar
e P e j

QK Cancel |
/)
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éCorrect Answer  © Your Answer

DOutlook Options EHE
-
General . . . —
& Change the settings for calendars, meetings, and time zones.
kail
Calendar Work time
Contacts -_L'/l Wiark hours: -
- 2 start time: 10:00 Al x|
asks e
End time: 5:00 PM =]
IEAERS e ot workweek: [ sun ¥ Mon W Tue W owed W Thu W Fri [ sat
Search First day of week: 'v"-_-‘ednesdagj
Mobile Firstweek of year: |First 4 day WEEj
Language Calendar options
Advanced °% V' Default reminders: ISU minutesj
Customize Ribbon = v Allove attendees to propose new times for meetings
Quick Access Toolbar Use this response when proposing a new meeting time: f’-\.ccept j
AT Add holidays to the Calendar:  Add Holidays | | |
Change the permissions far viewing Free/Busy information: ~ Free/Busy Options |
Trust Center
ol Enable an alternate calendar
| Arabic =l |Gregorian 7|
[ wihen sending meeting requests outside of your organization, use the iCalendar format
[T show bell icon on the calendar for appointments and meetings with reminders
Display options
) Default calendar color: @ -
9
_'(
I Use this color on all calendars
Date Mavigator font:
Font.., & pt. Segoe LI
I Show Click to Add prompts in calendar
[ O SO S S0 QS SO SO 10 Q- —r ;I
QK Cancel |
A /)
Answer: A

4.Kevin works as a Support Analyst for White Well Inc. He uses Microsoft Outlook 2010 for messaging
and e-mailing. MS Outlook has been configured to use an IMAP account. He creates a task request and
sends it to multiple recipients. He wants to send an informative e-mail that gives information about the
start date, due date, subject, priority, actual work, status, etc about the task request. He has to click an
option in the task window. Mark the option that he will use to accomplish the task.

A.

Tazk

[
0 X 3 8

= r= > [~ %) Privat
| j :,a J ‘/g :/| ,-‘ v (2] Private
J = = = 'J ¥ HighImportance
Sawe & Delete Forward OneMote Task |Details kMark  Assign|Send Status | Recurrence | Categorize Follow
Close Complete  Task Report - Up~ I lowImportance
Actions Shid Manage Task Recurrence Tags
Answer: A

5.You work as a System Analyst for InfoTech Inc. You create a meeting request to invite several
attendees for a meeting. Now you want to ensure that you do not receive any response from attendees
indicating whether they plan to attend the meeting or not. For this, you have to click an option on the

Meeting tab.

Mark the button on the Meeting tab to set the meeting response options.
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heeting

X g 3
N
=

Delete to
o Cogll;nodary@

= ﬁ [E¥ ~ =
= Bus < Recurrence
= 9‘/ = =] w A I:‘ C
Appointment| Scheduling Cancel 6 Time Fopes | -ategorize Zoom
Trwitation| 4 - - 4
Actions Shiooa Attendess Options P Tags Zoom

15 minutes -

-

A.
Answer: A

6.Choose and reorder the required steps to create a rule that will apply high importance to all emails that
satisfy the following criteriA.

1. Send email from peter@InfoTech.com account.

2. The sent emails must contain the "Meeting" word in the subject field.

NotE. The rule must omit the emails that are flagged as "Do not Forward".

| " Correct Answer & ‘Your Answer |
Correct Steps Choose From Here

;Ijﬂ Click Manage Rules & Alerts. =]

Click the specific words word.
Click the people or public group word.
jﬂ Select the except if it is flagged for action exception.
Click the action word.
Select the from people or public group action.
Specify the importance.
Click the importance word.
Select the Stay Organized template.
Select the email address.
Specify Do not Forward option.
Select the with specific words in the subject action.
Select the Stay Up to Date template.

hd| Select Apply rule on messages I receive template. =]
4 | 2 4 | |
" Correct Answer * Your Answer
Correct Steps Choose From Here
~ jﬂ Click Manage Rules & Alerts. =
Click the specific words word.

Click the people or public group word.
jﬂ Select the except if it is flagged for action exception.
Click the action word.
Select the from people or public group action.
Specify the importance.
Click the importance word.
Select the Stay Organized template.
Select the email address.
Specify Do not Forward option.
Select the with specific words in the subject action.
Select the Stay Up to Date template.
Id Select Apply rule on messages I receive template. I

A a |;| 4 I B

Answer: A

7.Choose and reorder the steps required to create a calendar group named 'Employee’ that includes
Employees contact group, and contacts named Henry Stuart, Mike Wilson, and Patricia.

| ' Correct Answer Your Answer |
Correct Steps Choose from here
;Ijﬂ Click the OK button. =]
The Create New Calendar Group dialog box appears.
Select member names in the Select Name: Contacts dialoc
jﬂ Type names for the new calendar group.
Click the New button,
Click the Calendar view.
Select the Create New Calendar Group option.
Click the OK button.
Click the Calendar Groups button in the Home tab.
Click the New Items button.
Click the Open Calendar button.
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orrect Answer ¢ Your Answer

Correct Steps Choose from here
Click the Calendar view. ;Ijj Click the New Items button. =
Click the Calendar Groups button in the Home tab. Click the Open Calendar button.

Select the Create New Calendar Group option. Click the New button.
The Create Mew Calendar Group dialog box appears. jj

Type names for the new calendar group.

Click the OK button.

Select member names in the Select Name: Contacts dialog
Click the OK button.

A W - . bt

Answer: A

8.Mark works as a Support Analyst for White Well Inc. He uses Microsoft Outlook for scheduling
meetings and e-mailing. MS Outlook has been configured to use a POP3 account. He wants to
create a recurring appointment that satisfies the following criteriA.

1. It will start at 12:00 AM and end at 12:40 AM.

2. It will recur from 17th Dec to 27th Dec.

3. It will recur on every Monday, Tuesday, Saturday, and Wednesday.

Perform the appropriate actions in the Recurrence dialog box to make the appointment recurring.

" Correct Answer ™ Your Answer

Appointment Recurrence |
— Appoinkrment Lirme

Start: [ 1:30 AM =l

End:  [11:30 PM =l

Duration: |3 hour j

~Recurrence patktern

£ Daily Recur every |1 week(s) on;

T Weekly v sunday [ Monday [~ Tuesday [T Wednesday
7 Morithly ¥ Thursday V¥ Friday ™ saturday
i Yearly

—Range of recurrence
Skart:  [12/29/2010 j " Mo end date
i~ End after: IE! ACCURrENCES

T Endby:  [12/01/2010 Bl

Ok | Cancel | Femove Recurrencel
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Correct Answer ¢ Your Answer

]|

Appointment Recurrence

— appointment Eime

[12:00 AM
[12:40 AM

Curation: I 40 min

Skark:

End:

—Recurrence patkern

£ Daily Recur every |1 weekis) on:

% weekly ™ Sundaw v Monday [V Tuesday v wednesday
£~ Monthly ™ Thursday ™ Friday V¥ saturday

i vearly

~Range of recurrence

Sktark: (121772010 j " Mo end date
™ End after: IE OCCUFFEMCES
& Endby:  [12/27/2010 hd
]34 | Cancel | Remove RecurrencEl
Answer: A

9.Derek works as a Marketing Manager for Blue Well Inc. Derek is using Microsoft Outlook 2010 for
messaging and e-mailing. MS Outlook has been configured to use the Derek@InfoTech email account.
In Outlook 2010, e-mail messages in his Inbox are organized by Date, and are arranged by
Conversation. Outlook groups messages that share the same subject into conversations that can be
viewed, expanded, or collapsed.

Mark the option or button on the Home tab to remove and send all previous and future e-mail

message conversations related to the Sales Details email directly to the Deleted Items folder.

Hame
== 1 .
.] _ % algnore x i ¥ .;& E Mg ‘E Fued:emp
5 Clean Up - ¢ ¢ o 13 Deepika SentIte.. |-
I e I e Celete Reply  Reply Forward B pgore = -, _
E-mail | Ttemns ~ | & Junk = Al = b To Manager B
I ey Celete Respond Quick Steps
A.
Answer: A

10.Mark works as a System Analyst for InfoTech Inc. He uses Microsoft Outlook 2010 for messaging and
e-mailing. MS Outlook has been configured to use an Exchange account.

He wants to create a quick step named FwD.emp, so that he can quickly and easily manage his mailbox
by using the shortcut key combination Ctrl + Shift + F9. He wants the following actions to be automated by
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the quick step:

1. Areply via an e-mail to employees@InfoTech.com with a high importance meeting request.
2. Send an e-mail with the Subject: URGENT MEETING.

3. Send an e-mail with the Location: San Fransisco.

4. Send an e-mail with the text: "Meeting with Latest Updates on Sales".

5. Send an e-mail with a small "hover box" containing the following information about the

item being hovered over:

"This quick step will reply to this email with a meeting request to all members"

Which actions will he perform in the Edit Quick Step dialog box to create the quick step?

| " Correct Answer & Your Answer |
Edit Quick Step EE

/ MName:
h‘% [Mew Quick Step

Add actions below that will be performed when this quick step is clicked on.

Actions

| Mark as unread - X

Tou.. | |emai| contacts &

Hide Ophions

Subject: RE:

Location: Location

Importance: | Low j
Text: message

¥ automatically send after 1 minute delay.

Add Action |

Cptional
Shorkout key: ICtrl + Shift + F& j
Tooltip kexk: Tool Tip

Finish I Cancel
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| % Correct Answer " Your Answer |
Edit Quick Step i B3

f Mame:
h‘} |Fud-emp

&dd actions below that will be performed when this quick step is clicked on.

ackions

| Reply with Meeting j X

Ta... | Iempln*_-;eea@lnfnTech.n::l:um 8/

Hide Opkions £

Subject: RE: URGENT MEETING

Location: San Fransisco
Importance: | High j
Texk:

Meeting for Latest Updates on Sales

[T automaticaly send after 1 minuke delay,

Add Action |

Cptional
Shortcutkey: | Ctrl + Shift + F9 =]
Tooltp bext: |Thjg guick step will reply this email with a meeting request to all the
Finish I Cancel
Answer: A

11.You work as a Support Analyst for Soft Well Inc. You are using Microsoft Outlook 2010 for messaging
and emailing. MS Outlook has been configured to use an IMAP account. Your colleague Mark Smith
belongs to a social network site that you also use.

You want to see his status updates, comments, messages, and alerts from the social network sites, all in
one location in Outlook 2010. Mark the option in the following image that you will use to see a list of all
email items that you share with Mark, such as e-mail messages you have exchanged, attachments, and
meetings.

Home Send s Receive Folder e

'.Q Change Wiew =

T.L Reverse Sort E Mavigation Pane = I- !

=] Add Columns |_:§-| Reading Pane -

; ; Arrange People | Windou
) Reset view G SEATEE Ey~ #=Expand/Collapse ~ ETD-DD Bar - Pake * -

[=—]
= Show as Conversations l
g Wiewe Settings

Current Wiew Conversations Arrangement Layout People Paneg
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Answer: A

12.Peter works as a Support Analyst for White Well Inc. He uses Microsoft Outlook 2010 for messaging
and e-mailing. MS Outlook has been configured to use a POP3 account. Peter uses his business cards to
send the contact information about him. He wants to ensure that the pictures in the business cards take
50% area of the card so that they look clearer, as shown in the following images:

Peter Parker Peter Parker

% Produa Marnger hddu'."t M.\F‘lﬂgtf

v
‘.df SHHI2TSINT SH93275937
v R prenguertitycom

= :
y t". : peeterifuwce rhify.oom
D
. e

Contact

H N4 =] | [BEL %3 certificates  [87 = & =

¥ kb iy (N (89|82, = By 8 ] (s @ | &)

H m:_EI =1 =4 =i 1= B2 41 Fields B 2 - v | & P S
Save & Delete Sawe & Forward Oneflote | |General| Details E-mail Meeting More | ASddress Check | Business |Picture

Close Mews = < < Book Mames Card <
Actions Shioe Communicate Mames Cptigns

A.
Answer: A

13.You work as a Support Analyst for White Well Inc. You are using Microsoft Outlook for messaging and
e-mailing. MS Outlook has been configured to use an Exchange account. You are composing a message
that contains security related information of the company. You want to configure Outlook in such a way
that it will accomplish the following tasks:

1. It returns a receipt that tells you that a message was opened.

2. It returns a message notification in your Inbox that the e-mail message was delivered to

the recipient's mailbox.

3. It returns a message notification in your Inbox that tells whether the recipient has seen it

or read it.

4. The message should be delivered by 22nd Dec 2011 at 5 pm.

5. The message should be expired by 25th Dec 2011 at 5 pm.

Perform the appropriate actions in the following Properties dialog box to configure the message delivery
options.
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" Correct Answer & Your Answer

e N |

Settings Security

J_ Importance: Im ELi;‘f‘-'J Change security settings For this message.
Sensitivity: I Mormal "I = Security Settings |

¥ Do not Autodrchive this item
Moking and Tracking options

=1 7 Use wating buttons: IF*.F:F:FD‘-;'E Reject j
- [ Request a delivery receipt For this message
[~ Request a read receipt for this message

Delivery options

\5'5. [ Have replies sent ko I Select Mames |

I”" Do not deliver before: {42/2/2010 j |1 P j
[ Expires after: |12_-"2_-"2i]1(] j |2 AM j

¥ Save copy of sent message

Contacts... | I
Cateqories vl IHDHE

Close

é::orrect Answer " Your Answer

Properties
Settings Security
_&;ﬂ Importance: | Low - LEI‘_'_J Change security settings For this message.

fg?
Sensitiviy: IHnrmaI 'l Security Settings |

v Do not Autodrchive this ikem
‘oking and Tracking options

= T Use waoking buttons: |ﬁ~.ppruve Reject j

[¥ Reguest a delivery receipt for this message

[w Request a read receipt For this message

Delivery options

E:éj [” Have replies sent tu:l Select Mames |
¥ Donat deliver before: |12_,-‘22_,-‘2[|11 j |5 = ﬂ
W Expires after: [12/25/2011 =l lspm hd

v Save copy of sent message

Contacks. .. | I
Cateqories vl IHDHE

Close

A.

Answer: A
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14.David works as a Support Analyst for White Well Inc. He uses Microsoft Outlook for scheduling
meetings and e-mailing. MS Outlook has been configured to use a POP3 account. David has scheduled a
business meeting that will occur regularly on 10 A.M. from July 30, 2008 to Sept 15, 2008.

Due to some other meetings, David wants to change the time of the business meeting that is going to be
held on Aug 27, 2008. He wants to set the meeting time to 3 P.M.

Choose and reorder the required steps to update the meeting occurrence.

 Correct Answer ¥ Your Answer
Correct Steps Choose from here

— jj Click Edit the Series. -~
Change the time.

Click the Scheduling button.
jj Select the Open this occurrence radio button.
Click Save & Close.
Select the Open this Meeting radic button.
Select the Open the Series radio button.
Open the meeting to change it.

| Correct Answer Your Answer

Correct Steps Choose from here

Open the meeting to change it. ;Ijj Select the Open this Meeting radio button. =

Select the Open this occurrence radio button. Click Edit the Series.

Change the time. Click the Scheduling button.

Click Save & Close. jj Select the Open the Series radio button.

&l |

A q | 4 |
Answer: A

15.Peter works as a Support Analyst for White Well Inc. He uses Microsoft Outlook 2010 business cards
to save the contact information of an identity. MS Outlook has been configured to use a POP3 account.
Peter opens the contact, and he wants to send his business card to other users in such a way that only

the .vcf file of the contact will be available to the recipients. Which of the following actions will he take to
accomplish the task?

A. Send the business card in the Internet format.

B. Send the business card in the plain-text format.

C. Send the business card in the Business Card format.
D. Send the business card in the PDF format.

Answer: A

16.You work as a Support Analyst for White Well Inc. You are using Microsoft Outlook for messaging and
e-mailing. MS Outlook has been configured to use an Exchange account. You are composing a message
that contains security related information of the company. You want to configure Outlook in such a way
that it will accomplish the following tasks:

1. It returns a receipt that tells you that a message was opened.
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2. It returns a message notification in your Inbox that the e-mail message was delivered to

the recipient's mailbox.

3. It returns a message notification in your Inbox that tells whether the recipient has seen it

or read it.

4. The message should be delivered by 22nd Dec 2011 at 5 pm.

5. The message should be expired by 25th Dec 2011 at 5 pm.

Perform the appropriate actions in the following Properties dialog box to configure the message delivery
options.

" Caorrect Answer ™ Your Answer
Properties

Sektings Security

o Importance: I Law vI (i ] Change security setkings For this message.
=i ‘a ?
Sensitivity: I Mormal 'I Security Settings |

v Do not Autodchive this ikem
Moting and Tracking options

1 ¥ Use woking buttons: Iﬁ.pprnve Reject j

[~ Request a delivery receipk For this message

[~ Reguest a read receipt: For this message

Delivery options

\_L:'E p [ Have replies sent ta: I Select Mames |

[~ Do not deliver befare: |12_.-'2_.-‘2|:]1|j j |1 F_I j
[ Expires after: |12_.-'2_."2|:]1|:] j |2 A j

v Save copy of sent message

Contacks.,.. | I
Categories vl IHDI‘lE

Close
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'F ;‘.:orrect Answer  © Your Answer

Properties E |
Sektings Security

i Importance: I Law ,l [ ] Change security settings far this message.
s i
Sensitivity: I Mormal "l Security Settings |

v Do not Aukodrchive this ikem
‘Woting and Tracking opkions

: c}) I Use voting buttons: Iﬁ.pprnve Reject j

[V Request a delivery receipt For this message

[ Request aread receipk For this message

Delivery options

x.I:'_. [” Have replies sent to: I Select Names
= SelectNames |
¥ Do nat deliver before: [12/22/2011 j | j
=l Bl

¥ Expires sfter: [12/25/2011

(&3]

P.I
P.I

[}

v Save copy of sent message

Contacts. .. | I
Cateqgaories vl IHDne

Close

A.
Answer: A

17.David works as a Support Analyst for White Well Inc. He uses Microsoft Outlook for messaging and
e-mailing. MS Outlook has been configured to use an IMAP account. He wants to print the calendar that
comprises the details of a single month. He wants to ensure that the calendar acquires the following
properties:

1. Inits layout, it prints two pages.

2. It prints the details from 9 A.M. to 5 P.M.

3. The paper source of the paper in the Manual Paper Feed.

4. Orientation landscape.

5. Reverse the position of the right and left section of the header and footer so that the

information in the left section on an even page is printed in the right section on an odd

page.

6. The size is sheet booklet.

What actions will he take in the Page Setup dialog box to accomplish the task?
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" Correct Answer ™ Your Answer
Page Setup: Daily Style EE

Style pame:  Daily Style

Farrmnak I Paper I HeaderFooker I

—Prewview:
— (]|
— options —Fonks
Layout: |1 page/day | Date headings
24 pt. Tah Font
Include: W TaskPad I i TEInEne
V¥ Motes area (blank) Appoinkmenks
¥ Maotes area (lined) IB pt. Tahaoma Font
Print From: |5 A j
Print £o: IB P j ~Shading
I¥ Print using gray shading

Cancel | PrintPreview Print
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% Correct Answer " Your Answer

Page Setup: Daily style H

Skyle name: IDain Shyle
Farmat ] Faper I HeaderFooker I

Headet:

IE pt. Times Mew Faman Font |

Fooker:
IS pt. Tahama Font |
[User Mame] [Page #] [Dake Prinked]

il iz [e2] [ e

¥ Reverse on even pages

Cancel 8] PrintPreview Print

Answer: A

18.Choose and reorder the required steps to create a rule that will apply high importance to all emails that
satisfy the following criteriA.

1. Send email from peter@InfoTech.com account.

2. The sent emails must contain the "Meeting" word in the subject field.

NotE. The rule must omit the emails that are flagged as "Do not Forward".

' Correct Answer % Your Answer

Correct Steps Choose From Here
:de Select the check boxes for options. =]
Click the New Rule button.

Click the Rules button.
jj Select Apply rule on messages I receive template.

Select the from people or public group action.

Select the except if it is flagged for action exception.

Click the specific words word.

Select the Stay Up to Date template.

Select the email address.

Specify the word.

Click the people or public group word.

Click the File tab.

Click the next button.

|| Select the Stay Crganized template. ||

« | i < | 2l
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{ Correct Answer € Your Answer

Correct Steps Choose From Here
Click the File tab. ;Ijj Select the Stay Organized template. =
Click the Rules button. Select the Stay Up to Date template.

Click Manage Rules & Alerts.

Click the New Rule button. jj
Select Apply rule on messages I receive template.
Select the from people or public group action.
Select the with specific words in the subject action.
Click the people or public group word.

Select the email address.

Click the specific words word.

Specify the word.

Click the next button.

Select the mark it as importance action.

Click the importance word. | Jid
AL | | B . | b
Answer: A

19.Choose and reorder the required steps to set Outlook 2010 as your default program, so that the e-mail
applications on your computer can use Outlook 2010.

" Correct Answer % Your Answer
Correct Steps Choose from here

;Ijj Click the Advanced pane. =]

Click the select the Make Outlook the default program for
Click the Options pane.

jj Click the OK button,

Click the Add-Ins pane.

Click the File tab.
Click the General pane.

I L]
‘. | 2 <| |
F iCorrect Answer ¢ Your Answer
Correct Steps Choose from here
Click the File tab. ;Ijj Click the Add-Ins pane. =]
Click the Options pane. Click the Advanced pane.

Click the General pane.
Click the select the Make Outlook the default program for E jj
Click the OK button.

A. 4] | 3| . | [
Answer: A

20.David works as a Support Analyst for White Well Inc. He uses Microsoft Outlook 2010's business card
to save contacts information. MS Outlook has been configured to use an Exchange account. He includes
two business cards in an e-mail message to send the contact information about the suppliers to Mr.
Thompson and Mr. Jackson.

By using the business cards, David will visually communicate the corporate and personal identity of the
suppliers. He sends the e-mail message. However, the recipient of the e-mails receives the cards that are
only images and are non-clickable. They also receive an attached .vcf file that contains the information
about the contact. Which of the following is a cause of the issue?

A. Recipients are using HTML text format to view the e-mail.

B. Business Cards are added as an e-mail signature

C. Recipients are using Outlook 2010.

18/19



The safer , easier way to help you pass any IT exams.

D. Recipients are using plain text format to view the e-mail.
Answer: A
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